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Abstract

This article describes an experimental protocol using electrospray-ion mobility-

mass spectrometry (ES-IM-MS) and energy-resolved threshold collision-induced

dissociation (TCID) to measure the thermochemistry of the dissociation of negatively-

charged [amb+M(II)+NTA]-  ternary complexes into two product channels: [amb+M(II)]

+ NTA or [NTA+M(II)]-  + amb, where M = Zn or Ni and NTA is nitrilotriacetic acid.

The complexes contain one of the alternative metal binding (amb) heptapeptides with

the primary structures acetyl-His1-Cys2-Gly3-Pro4-Tyr5-His6-Cys7 or acetyl-Asp1-

Cys2-Gly3-Pro4-Tyr5-His6-Cys7, where the amino acids' Aa1,2,6,7 positions are the

potential metal-binding sites. Geometry-optimized stationary states of the ternary

complexes and their products were selected from quantum chemistry calculations

(presently the PM6 semi-empirical Hamiltonian) by comparing their electronic energies

and their collision cross-sections (CCS) to those measured by ES-IM-MS. From the

PM6 frequency calculations, the molecular parameters of the ternary complex and its

products model the energy-dependent intensities of the two product channels using

a competitive TCID method to determine the threshold energies of the reactions that

relate to the 0 K enthalpies of dissociation (ΔH0). Statistical mechanics thermal and

entropy corrections using the PM6 rotational and vibrational frequencies provide the

298 K enthalpies of dissociation (ΔH298). These methods describe an EI-IM-MS

routine that can determine thermochemistry and equilibrium constants for a range of

ternary metal ion complexes.

Introduction

This study describes a new technique using a commercially

available ion mobility-mass spectrometer that allows the

determination of the relative thermochemistry for the

dissociation of an alternative metal binding (amb) ternary

metal complex [amb+M(II)+NTA], where M = Zn or Ni and

NTA = nitrilotriacetic acid (Figure 1). These reactions model
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the dissociation of the amb-tagged recombinant protein

attached to the NTA-immobilized metal during immobilized

metal affinity chromatography (IMAC)1,2 . As an example,

this method is described using the amb heptapeptide tags

of amb A and H (Figure 2) (chosen from the previous

studies3,4 ,5 ,6 ,7 ,8 ,9 ,10 ,11 ,12 ) that exhibit Zn(II) and Ni(II)-

binding properties and, thus, have potential applications

as purification tags. However, the described process can

be used to evaluate thermochemical energies in any

organometallic system. These amb peptides have metal-

binding sites in the Aa1-Aa2 and Aa6-Aa7 positions that

compete with the carboxylate and amine sites of the NTA. The

three central amb amino acids provide a spacer (Gly3), the

hinge for the two arms (Pro4), and a long-distance π-metal

cation interaction (Tyr5).

The overall 1− charge state of the [amb+M(II)+NTA]-

complexes is determined by the protonation state of their

potential binding sites. Since there is Ni(II) or Zn(II) with the

2+ oxidation state, there must be a net of three deprotonated

negatively-charged sites. The molecular modeling of the

[amb+M(II)+NTA]-  complexes predicts that these are two

protons from the NTA and one proton from the amb (i.e.,

[amb-H+M(II)+NTA-2H]- ). The product channels contain an

ionic species and a neutral species (i.e., [NTA-3H+M(II)]-

+ amb or [amb-3H+M(II)]-  + NTA). In the manuscript,

"-3H" is excluded in the names of the complexes, but the

reader should know that the -3H is implied. The instrument

measures the relative intensities of the two ionic mass-

to-charge (m/z) species. A major attribute of ES-IM-MS

analyses is that it allows the examination of the reactivity of

a specific m/z species, as utilized here and in previous amb

studies3,4 ,5 ,6 ,7 ,8 ,9 ,10 ,11 ,12 .

Acquiring thermochemical data for large complexes using

collision-induced dissociation is a subject of significant

interest13,14 . Methodologies including the kinetic method are

not conducive to fitting data over a range of energies, nor

do they account for multi-collision environments15,16 ,17 ,18 .

Here, the threshold CID (TCID) method, developed using

guided ion beam tandem mass spectrometry by Armentrout,

Ervin, and Rodgers is applied19  to a new ES-IM-MS

instrument platform utilizing traveling-wave ion guides. The

TCID method allows for relative thermochemical analysis

of the dissociation of the ternary complexes into their two

product channels and includes a threshold law describing the

transfer of collision energy between the translational energy

of the reactant (ternary complex in this research) and an

inert target gas (argon in this case). The method includes

integration over the reactant's internal energy distribution20 ,

the translational energy distributions between the reactant

and target gas21 , and the total angular momentum

distributions22,23 . A dissociation probability and statistical

Rice-Ramsperger-Kassel-Marcus (RRKM) correction of the

kinetic shifts resulting from the limited time window for

observation of the products are included24 . For two

independent product channels, the competitive TCID method

allows for the simultaneous fitting of the two competing

product channels. Dissociation of the complex is through

an orbiting transition state, which has the properties of the

products but is held together by a locked-dipole25 . The TCID

method is incorporated into the CRUNCH program26 , and the

operation of the user interface is described here to evaluate

the thermochemistry of the two dissociation channels of

the ternary [amb+M(II)+NTA]-  complexes. The CRUNCH

program is available upon request from the developers26 .
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Protocol

NOTE:  Figure 1 shows an overview of the protocol.

1. Preparation of reagents

1. Purchase freeze-dried amb peptides (>98% purity) and

store them in a −80 °C freezer.

2. Purchase >99% purity zinc(II) nitrate hexahydrate and

nickel(II) nitrate hexahydrate.
 

CAUTION: Nickel(II) nitrate hexahydrate presents an

environmental and health hazard.

3. Purchase the nitrilotriacetic acid, poly-DL-alanine

polymers, ultrapure/trace metal grade ammonium

acetate, ammonium hydroxide, glacial acetic acid, and

HPLC grade acetonitrile.

2. Preparation of stock solutions

1. Peptide amb stock solution

1. Prepare an aqueous solution of 12.5 mM amb

concentration by weighing 10-20 mg of the freeze-

dried peptide using no less than three significant

figures and placing it in a 1.7 mL polypropylene

microcentrifuge tube.

2. Add the appropriate volume of deionized water

(>17.8 MΩ cm) to the microcentrifuge tube. Close

the lid and mix well with at least 20 inversions.

3. Create 50 µL aliquots from the 12.5 mM amb solution

and place them into marked 1.7 mL microcentrifuge

tubes. Store the aliquot stock solutions at −80 °C.

2. Metal ion stock solutions

1. Prepare the aqueous Zn(II) and Ni(II) solutions of

12.5 mM concentration by weighing 10-30 mg of

the metal nitrate hexahydrate using no less than

three significant figures and placing it in a 1.7 mL

polypropylene microcentrifuge tube.

2. Add the appropriate amount of DI water to the

microcentrifuge tube. Close the lid and mix well with

at least 20 inversions. Store 50 µL aliquot stock

solutions at −80 °C.

3. NTA ion stock solutions

1. Prepare an aqueous NTA solution by weighing

10-30 mg of the NTA using no less than three

significant figures and placing it in a 1.7 mL

microcentrifuge tube.

2. Add the appropriate amount of DI water to the

NTA in the microcentrifuge tube to achieve a final

concentration of 12.5 mM. Close the lid and mix well

with at least 20 inversions. Store 50 µL aliquot stock

solutions at −80 °C.

4. Ammonium acetate stock solutions: Weigh 30.8 mg of

ammonium acetate and add to 40 mL of DI water to

yield a 10 mM solution. Adjust the pH of the ammonium

acetate solution to pH 7.7 with 1 mM ammonium

hydroxide.

5. Poly-DL-alanine stock solution: Make a 1 mL, 1,000

ppm poly-DL-alanine (PA) stock solution by dissolving

1.0 mg of PA in DI water. Mix comprehensively. Create

50 µL aliquots and put them into individually labeled

microcentrifuge tubes. Store the 1,000 ppm solution at

−80 °C.

https://www.jove.com
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3. Electrospray-ion mobility-mass spectrometry
(ES-IM-MS) collision-induced dissociation (CID)
analysis

1. Prepare the instrument by cleaning the ES inlet tubing

and metal capillary by injecting 500 µL of 0.1 M glacial

acetic acid, followed by 500 µL of 0.1 M ammonium

hydroxide, and finally 500 µL of pH 7.7 ammonium

acetate solution.

2. Liquefy the 12.5 mM amb stock solution by bringing it to

room temperature. Create a final concentration of 0.125

mM amb by making two successive dilutions with DI

water. Mix comprehensively after each dilution.

3. Liquefy the 12.5 mM metal ion stock solution by bringing

it to room temperature. Create a final concentration of

0.125 mM metal ion by making two successive dilutions

with DI water. Mix comprehensively after each dilution.

4. Liquefy the 12.5 mM NTA stock solution. Create a

final concentration of 0.125 mM NTA by making two

successive dilutions with DI water. Mix comprehensively

after each dilution.

5. To make a 2 mL sample of the ternary complex, add

800 μL of 0.125 mM NTA solution and 400 μL of 0.125

metal ion solution to a 2 mL microcentrifuge tube, and

mix thoroughly with at least 20 inversions. Add 400 μL

of ammonium acetate solution (pH 7.7) and 400 μL of

0.125 mM amb solution, mix thoroughly with at least 20

inversions, and permit the sample to equilibrate for 10

min at room temperature.

6. Load the 2 mL sample into a 2.5 mL blunt nose syringe

and inject the sample into the ES of the instrument using

the instrument's syringe pump at a flow of 10 μL/min.

7. Place the instrument in negative IM-MS mode. Use the

typical operating conditions of the instrument27  for these

experiments as follows.

1. Inject the sample at a 10 µL/min flow rate into the ES

capillary held at −2 kV with a 500 L/h desolvation flow

rate of nitrogen. Set the ES source and desolvation

temperatures to 130 °C and 263 °C, respectively.

Set the sampling and extraction cones to 25 V and

3 V, respectively.

2. For the CID experiments, use the quadrupole mass

analyzer to select the isotopic pattern of the [amb

+M(II)+NTA]-  ternary complex using the m/z of the

monoisotopic peak with resolution settings of low

mass = 4.5 and high mass = 16.5.
 

NOTE: The [amb+M(II)+NTA]-  ions are passed onto

the sequential three traveling wave (T-wave) ion

guides.

3. Ensure that the trap T-wave has an argon gas flow

of 3 mL/min and a pressure of 2.83 x 10-2  mbar. Set

the collision energy (CE) to the trap at 5 V to avoid

any dissociation of the ternary complex. Let the trap

collect the ternary complex ions before releasing

(200 μs release time) them into the ion mobility (IM)

T-wave ion guide using a trap DC bias of 14 V, which

keeps dissociation of the complex at the IM entrance

to a minimum.

4. Ensure that the IM ion guide has a pressure of 0.507

mbar using a 20 mL/min flow rate of ultrapure N2

buffer gas. Ramp the T-waves in the IM with heights

of 7 V to 30 V and with velocities of 290 m/s to 801

m/s for each starting and ending sweep of the IM ion

guide.

https://www.jove.com
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5. Set the argon flow and pressure of the transfer T-

wave the same as the trap T-wave. The transfer T-

wave was used for the collision-induced dissociation

of the ternary [amb+M(II)+NTA]-  complex using the

transfer CE.

8. Select the m/z isotope pattern of the negatively charged

[amb+M(II)+NTA]-  complex using the transmission

quadrupole in resolving mode.

1. Identify the m/z isotope pattern by opening the mass

spectrometry program and selecting Spectrum.

Select Tools > Isotope model. In the pop-up

window, list the molecular formula of the complex,

check the box for Show Charged Ion, enter 1 for the

charge of negative one and click on OK.

2. In the displayed isotope pattern of the complex, note

the lowest mass peak. In the instrument software,

select Setup > Quad Profile. In the window that

opens, select Manual Fixed and enter the mass of

the lowest isotopic pattern peak. Click on Update

and then Close.

3. Select Setup again, and then click on Resolving

Quad. Collect the negative ion ES-IM-MS spectra

incrementally across a range of transfer collision

energies using a 5 min run duration and 2 s scan

time.
 

NOTE: Preliminary transfer energies can be tested

from 26-60 V in intervals of 2 V. The final range

of transfer collision energies examined should

demonstrate no dissociation of the ternary complex

at the lowest energy and complete dissociation into

the products at the highest energy. For high-quality

statistical analysis, this ES-IM-MS analysis should

be performed for each amb ternary complex at least

3x by different people and on different days to

determine means and standard deviations.

4. ES-IM-MS collision cross-section (CCS)
analysis

1. Clean the ES inlet tubing and the metal capillary with 500

µL of 0.1 M glacial acetic acid, followed by 500 µL of

0.1 M ammonium hydroxide, and finally 500 µL of pH 7.7

ammonium acetate solution.

2. Liquefy the 1,000 ppm PA stock solution to room

temperature and do two serial dilutions; dilute to 100 ppm

PA with DI water, and then dilute to 10 ppm PA solution

by diluting with a 1:1 ratio of DI water and HPLC-grade

acetonitrile.

3. Collect the negative ion IM-MS spectra of the 10 ppm

PA sample for 10 min using instrumental operating

conditions.
 

NOTE: The injection flow rate and ES source conditions

were the same as for the CID experiments (step 3.).

For measurements of the CCS, the quadrupole mass

analyzer was in non-resolving mode and passed all

ions onto the sequential three T-wave ion guides. The

operation of the trap T-wave and IM T-wave ion guides

was the same as for the CID experiments. The collision

energy of the transfer T-wave cell was at 4 V to allow ions

to pass through without dissociation.

4. Prepare each of the ternary complexes as described in

steps 3.2.-3.6.

5. Collect the IM-MS spectra of each ternary complex for 5

min.
 

NOTE: Use the same instrumental conditions as in step

4.3.

https://www.jove.com
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6. Collect the negative ion IM-MS spectra of the 10 ppm PA

sample for 10 min.
 

NOTE: The mean of the arrival times of the PA calibrants

collected before and after the amb ternary complexes are

used in the CCS determination.

5. Analysis of ES-IM-MS CID data

1. Identify the species by matching the theoretical m/z

isotope patterns of the ternary complex and its products

to the experimental IM-MS spectra.

1. Open the mass spectrometry program and select

Chromatogram to open a new window.

2. In the Chromatogram window, click on File > Open

to find and open the desired IM-MS data file.

3. Right-clicking the mouse, drag across the

chromatogram, and release. The MS spectrum will

be displayed in a separate Spectrum window.

4. In the new window displaying the spectra, select

Tools > Isotope Model. A small window will pop

up. Enter the molecular formula of the amb species,

check the Show Charged Ion box, and enter the

desired charge state. Click on OK.

5. To distinguish all the species in the IM-MS spectrum,

repeat this process in the Spectrum window and

record their m/z isotope range.

2. For the ternary amb complex and its products, use their

m/z isotope range to identify them and extract their arrival

time distributions (ATD).

1. Open the ion mobility separation software and select

File > Open to find and open the data file.

2. Left-click and drag with the mouse to zoom in on

the m/z isotope range of the ternary complex [amb

+M(II)+NTA]- .

3. Using the Selection tool, left-click and drag to select

the specific isotope range for [amb+M(II)+NTA]-  as

identified in step 5.1. Click on the Accept Current

Selection button.

4. To eliminate any coincidental m/z species or

background signal, use the Selection tool to choose

the ATD associated with the ternary complex. Click

on the Accept Current Selection button.

5. To export the ATD file to the mass spectrometry

software, go to File > Export, and then click on

Retain Drift Time. Rename the file if desired and

save the file in the appropriate folder.

3. Determine by integration of the area under the extracted

ATD curve the species' relative intensity.

1. In the Chromatogram window, open the saved

exported file from the ion mobility separation

software. Select Process and then Integrate. Use

a peak-to-peak amplitude setting of 20 and click on

OK.

2. Record the integrated area as shown on the

Chromatogram window. Repeat steps 5.2.2.-5.2.5.

for the two products, namely [NTA+M(II)]-  and [amb

+M(II)]- .

3. Repeat steps 5.2.1.-5.3.2. for each transfer collision

energy recorded.

4. Utilize the integrated ATD areas for the ternary complex

[amb+M(II)+NTA]-  and two products [NTA+M(II)]-  and

https://www.jove.com
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[amb+M(II)]-  at each transfer collision energy point to

normalize to a relative percentage scale.

1. Create a spreadsheet by entering the identities of the

ternary complex and its products and their integrated

ATD at each collision energy.

2. For each collision energy, utilize the summation

of the integrated ATDs for [amb+M(II)+NTA]- ,

[NTA+M(II)]- , and [amb+M(II)]-  to normalize their

individual ATDs to a relative percentage scale.

3. From the replicate TCID measurements, find the

mean and standard deviations of each data point.

Convert the lab-frame transfer collision energy

(Elab) to the center-of-mass collision energy (Ecm)

using the average masses of the argon (mAr)

collision gas and the ternary complex (mcomplex):

Ecm = Elab (mAr)/(mAr + mcomplex).
 

NOTE:  Ecm represents the maximum energy from

the collision with the argon gas, which is available

for dissociation of the ternary complex.

4. Plot the mean and standard deviation of

the individual percentage intensities of [amb

+M(II)+NTA]- , [NTA+M(II)]- , and [amb+M(II)]-  in a

graph of relative intensity (%) vs. center-of-mass

collision energy (eV) to exhibit how the species'

relative intensities change as a function of collision

energy.

6. Analysis of the average arrival times for
determining collision cross-sections (CCS)

1. Open the ion mobility separation software and the file

containing the IM-MS spectrum of the 10 ppm PA sample

collected with the transfer collision energy set at 4 V.

Extract the ATD of each of the single negatively charged

PA species and export the files to the mass spectrometry

software using the option Retain Drift Time (see step

5.2.5.). Repeat for the second PA calibrants file.

2. Open the ion mobility separation software. Use File

> Open to open one of the files containing the IM-

MS spectra of the amb ternary complexes recorded

between the PA calibrants. Extract the ATD of each

of the ternary complexes and export their files to the

mass spectrometry software using the Retain Drift Time

option (see step 5.2.5.).

3. Use a cross-sectional calibration method28  to calculate

the CCS of the ternary complex and its products.

1. In a spreadsheet, calculate the corrected CCS (Ωc)

for each of the single negatively charged PA species

from their CCS (Ω)29,30  measured in Helium buffer

gas31  using Equation 1, where z = charge of the

ternary complex, ec = 1.602 x 10−19  C; mN2 =

mass of nitrogen (u), and mion = mass of ternary

complex28 .
 

    (1)

2. Find the drift times (tD) of the PA calibrants

and the ternary complexes by first obtaining the

average arrival times (tA) from the maxima of

the corresponding ATD curves and then applying

Equation 2, where c = detector delay coefficient

(1.41 ms; check instrument as this can vary between

instruments) and m/z = mass-to-charge ratio of the

PA calibrant or amb ternary complex.
 

tD =tA    (2)

https://www.jove.com
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3. Create a graph by plotting the PA calibrants' tD vs.

Ωc. Then, using Equation 3, fit the data with a least-

squares regression to find the constants A' and B,

where A' corrects for the electric field, temperature,

and pressure in the instrument and B corrects for the

nonlinear behavior of the T-wave IM device.
 

Ωc = A' tDB    (3)

4. Utilizing the A' and B constants and the tD value

of the amb ternary complexes, calculate their Ωc

using Equation 3 and their Ω using Equation 1. The

CCS values estimated by this method have absolute

errors of about 2%29 .

7. Computational methods

1. Use the semi-empirical PM632  method implemented

in structural modeling and computational software33

to locate geometry-optimized conformers of the [amb

+M(II)+NTA]-  ternary complexes and the ion and neutral

product pairs: [amb+M(II)]-  + NTA and [NTA+M(II)]-  +

amb observed from the CID experiments. Refer to the

computation visualizer usage in the Supplementary File

for specifics on how to develop and submit calculations.
 

NOTE: For the present systems, the PM6 method

correctly reproduced experimental data, but in general,

any quantum chemistry method that is reliable and

computationally doable can be used.

2. Run geometry optimizations and frequency calculations

on multiple different starting structures to explore

different conformations, protonation states, and potential

binding sites. Record the electronic + zero-point energies

of each of the located stationary points for each of the

ternary complexes and their products.
 

NOTE: The starting structures for the geometry

optimizations should investigate different possible

combinations of binding sites and conformational

arrangements. The starting structures were based

on previously located B3LYP34  [amb+M(II)]-

conformers3,4 ,6 . For [amb+M(II)+NTA]- , NTA was

positioned to compete with the substituent sites of

the amb at the Aa1-Aa2-Aa6-Aa7 and the carboxylate

terminus for the singlet spin state of Zn(II) or the triplet

spin state of Ni(II).

3. Use a program that can perform accurate collision cross-

section measurements as measured in helium buffer

gas (CCSHe) using the atomic coordinates from these

quantum chemical calculations35 .
 

NOTE: Programs developed for calculating accurate

CCSHe from peptide structures located by

quantum chemical calculations include MobCal36  and

HPCCS37,38 .

4. Choose the lowest energy conformer exhibiting the

Lennard-Jones CCSHe that agrees with the IM-MS-

measured CCSHe for selecting the structures of ternary

complexes and dissociation products to include in the

CRUNCH modeling below.

8. CRUNCH modeling

1. Create a text file in the format described in the discussion

section ("CRUNCH input text file format").
 

NOTE: The file includes the following columns: (−1)

center-of-mass collision energy (Ecm), (1) mean of the

relative intensity of the [amb+M(II)]-  product, (2) standard

deviation of the [amb+M(II)]-  intensity, (3) mean of the

https://www.jove.com
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relative intensity of the [NTA+M(II)]-  product, and (4)

standard deviation of the [NTA+M(II)]-  intensity.

2. Model the Ecm-dependent intensities of the two reaction

channels [amb+M(II)+NTA]-  to [amb+M(II)]-  + NTA and

[amb+M(II)+NTA]-  to [NTA+M(II)]-  + amb using the TCID

technique in the CRUNCH program.
 

NOTE: Use the PM6 vibrational and rotational

frequencies for the ternary complex and the two ion and

neutral product channels. Use average masses of the

ternary complex, argon collision gas, and ion and neutral

products. Use values from the PM6 calculations or the

NIST database for the polarizabilities (Å3 ) and dipole

moments (Debye) for the neutral products.

1. From the CRUNCH main menu, open the text

file (.GB5) containing the Ecm-dependent relative

intensities of the products. Reply No to read

parameters.

2. From the CRUNCH main menu, select Modeling

> Set all parameters. From the reaction model

options, choose the default Threshold CID option

followed by RRKM with integration over the

energy transfer distribution of the ternary

complex20 , enter 2 for independent product

channels modeled, and select Calculate cross

sections. Enter No to Do any two product

channels have the same ion mass?

3. For Product Channel # 1, enter column [1] for

the experimental data of the [amb+M(II)]-  product,

column [2] for the standard deviations of the [amb

+M(II)]-  product, column [5] for the unconvoluted

model cross section, and column [6] for the

convoluted model cross section. Enter 0 for

residuals of fit.
 

NOTE: These column numbers correspond to the

columns in the input file in step 8.1. as described in

the discussion ("CRUNCH input text file format").

4. For Product Channel # 2, enter column [3] for

the experimental data of the [NTA+M(II)]-  product,

column [4] for the standard deviations of the [NTA

+M(II)]-  product, column [7] for the unconvoluted

model cross section, and column [8] for the

convoluted model cross section. Enter 0 for

residuals of fit.

5. For the type of unconvoluted model, choose 0

K cross section (kinetic shift included), which

includes the statistical RRKM correction of the

kinetic shifts due to the 50 μs time window from the

collision cell to the TOF detector18 .

6. For the convolution options, choose Tiernan's

double integral, which includes the convolution

over translational energy distributions between the

ternary complex ion and the argon collision gas21 .

7. For the numerical integration method, choose

gaussian quadrature with pre-saved cross

sections, followed by the number of integration

points = 32, the number of standard deviations =

3.0, and the number of standard deviations for the

second integral = 3.0.

8. The mass of ternary complex ion (u) is read

automatically from the .GB5 text file, followed by the

mass of the collision gas (39.948 for argon); use the

defaults of 0.20 eV for the FWHM of the ion beam

and 298.15 K for gas temperature. The program

automatically reads in the minimum and maximum

https://www.jove.com
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center-of-mass collision energies from the .GB5 text

file; use the default value for the minimum energy

increment.

9. Use the default value for the scaling factor Sig0, No

for allow scaling of individual product channels,

and the default values for N and M. For the method

for the g(i) calculation, choose integrate over ro-

vibrational density of states, which includes the

internal energy distribution20  of the ternary complex

[amb+M(II)+NTA]- .

10. From the options for entering the molecular

parameters, enter G to read the structural modeling

file33  with the PM6 vibrational and rotational

frequencies of the ternary complex. Reply Yes to the

question is one of the reactants atomic? Write the

location and name of the modeling file.
 

NOTE: The other options for entering the vibrational

and rotational frequencies include read parameter

file, which will read in the parameters from a text file,

or edit/enter constants, which allows for manual

entry of each parameter.

11. Scale the frequencies using the NIST-recommended

PM6 scaling factor (1.062). For more details on

scaling, see the discussion ("scaling factors for the

vibrational frequencies"). The number of atoms in

the ternary complex is read from the file. Reply No

to is the molecule linear? Enter the description of

the reactants (e.g., H+Zn+NTA- + Ar).

12. Enter 1 for the charge on ion and 1.664 for the

polarizability of the argon gas39 . The mass of ion

and mass of target are for the ternary complex and

argon, respectively, and are automatically read from

the .GB5 text file. Enter 0 for harmonic vibrations.
 

NOTE: The following options are for choosing

different scaling factors for high or low vibrational

frequencies. Enter 1.062 for high frequencies and

0.0 for low frequencies (see discussion: scaling

factors for the vibrational frequencies). The scaled

frequencies are shown. Choose 0 to select No

Change.

13. Hit Enter to read the 1-D and 2-D

rotational constants from the structural modeling

file33  entered in step 8.2.10. Select default values

of 0 for the hindered rotor treatments and 1 for

molecule symmetry.
 

NOTE: The program shows the inputted data; hit

Enter for No Changes.

14. Choose the default 300 K for reactant temperature.

Select Integration for the method for reduction of

density of states array. Select Yes to truncate

the energy distribution. Enter 40000 cm−1 for

maximum energy for distribution, 2.0 cm−1 for

bin size, and 32 for number of points in energy

distribution.
 

NOTE: Hit Enter 2x and check that the truncated

32-pt array has a population >0.9. If >0.9, enter No

to change bins or condensation factor. If <0.9,

enter Yes and change the maximum energy for

distribution and/or bin size.

15. For parameters for TCID/RRKM model, choose

Yes for Change, enter 0 for fixed time, and

0.000050 s for the upper limit of the detection

window. For the utilized instrument, this is the time

ions take to travel from the transfer collision cell to

the TOF detector and is calculated using Equation

2.

https://www.jove.com
https://www.jove.com/


Copyright © 2022  JoVE Journal of Visualized Experiments jove.com June 2022 • 184 •  e63722 • Page 11 of 27

16. For energized molecule, enter C to copy values

from the reactants already entered. Enter −1 for

source transition state (TS), 0 for destination TS, and

P to proceed.

17. For product channel 1, select 1 for single

transition state from the dissociation channel

options and 0 for none for the sequential

dissociation. For the transition state type, choose

1 for orbiting.

18. Select G to read the modeling program files

that contain the PM6 rotational and vibrational

parameters for the [amb+M(II)]-  + NTA products.

Enter No for is one of the PSL TS species atomic?

Enter the location and name of the [amb+M(II)]-  file.

Use 1.062 for scale frequencies, hit Enter for the

number of atoms, and enter No for is the molecule

linear?

19. Enter the location and name of the modeling

file that contains the vibrational and rotational

frequencies for the NTA product. Use 1.062 for scale

frequencies, hit Enter for the number of atoms,

and enter No for is the molecule linear? Enter the

description of the orbiting TS, e.g., H+Zn-...NTA.

20. Enter 1 for charge of [amb+M(II)]-  ion, and enter the

polarizability (16.12 Å3) and the dipole moment

(4.6183 Debye) of NTA. Select 0 K for rotational

temperature and locked-dipole for the treatment

of the orbiting transition state. Enter the average

masses (u) of the [amb+M(II)]-  ion and NTA.

21. Enter 0 for harmonic vibrations. Enter 1.062 for

high frequencies and 0.0 for low frequencies.

See the discussion section for further details of

scaling frequencies; the scaled frequencies are

shown. Choose 0 to select No Change. Hit Enter

to read the 1-D and 2-D rotational constants from

the modeling files. Select 0 for hindered rotors,

1 for molecule symmetry, and 1 for reaction

degeneracy. Enter the No Changes option.

22. For product channel 2, select 1 for single

transition state, 0 for none for the sequential

dissociation, and 1 for orbiting for the transition

state type.

23. Select G to read in modeling files that contain the

PM6 rotational and vibrational parameters for the

[NTA+M(II)]-  and amb products. Enter No for is one

of the PSL TS species atomic? Write the location

and name of the [NTA+M(II)]-  modeling file.

24. Use 1.062 for scale frequencies, hit Enter to read

the number of atoms, and enter N for is the

molecule linear? Write the location and name of the

amb modeling file. Use 1.062 for scale frequencies,

hit Enter for the number of atoms, and enter N for is

the molecule linear?

25. Enter the description of the orbiting TS (e.g., NTA

+Zn-...H). Enter 1.0 for charge of [NTA+M(II)]-  ion,

and enter the polarizability (Å3) and the dipole

moment (Debye) of the amb. Select 0.0 K for

rotational temperature and locked-dipole for the

treatment of the orbiting transition state. Enter the

average masses (u) of the [NTA+M(II)]-  and amb

products.
 

NOTE: The output file contains the polarizability and

dipole moments of the amb. The polarizability is in

units of Bohr3  and needs to be converted to the units

of Å3 .

https://www.jove.com
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26. Enter 0 for harmonic vibrations. Enter 1.062 for

high frequencies and 0 for low frequencies.

See the discussion for more details on scaling

frequencies. The scaled frequencies are shown.

Choose 0 to select No Change. Hit Enter to

read the 1-D and 2-D rotational constants from

the modeling files. Select 0 for hindered rotors,

1 for molecule symmetry, and 1 for reaction

degeneracy. Enter No Changes.

27. To handle inactive 2-D rotations, select the

default options statistical angular momentum

distribution and integrate P(E,J) over J

distribution. Use the default value of 32 in the

number of points in integration.
 

NOTE: These selections choose the method for

integration over the total angular momentum J

levels16,  17 . The resulting output allows the

investigator to check that all the input is correct.

28. Select the activation energies relative to the

energized molecule option and enter relative

energy (eV) for product channel 1 that is close to

the threshold energy observed in the graph of the

relative intensity vs. center-of-mass collision energy

of the [amb+M(II)]-  product (Figure 4).

29. For product channel 2, enter relative energy (eV)

that is close to the threshold energy observed in the

graph of the intensity vs. center-of-mass collision

energy of the [NTA+M(II)]-  product. To calculate the

number of states for each product channel, use a

bin size of 2.0. Press Enter and then No to continue.

30. From the Model menu, select Optimize parameters

to fit data, and enter the minimum energy and

maximum energy to begin and end the data fit,

respectively.
 

NOTE: Use a small energy range that includes

the thresholds of both channels. For further details,

see discussion: energy range for fitting the selected

TCID model to the experimental data.

31. Select -1 for weighting modes experimental

standard deviations. Based on the data, select a

minimum acceptable std. deviation of typically

0.01 to 0.001. Select No for optimized scaling

of individual channels and 0 for the number of

iterations.
 

NOTE: An alternative to using standard deviations is

the statistical option.

32. Use the default value for the E0 convergence limit

and select No to hold any parameter at present

value. Enter 0.5 and 2.0 eV for the lower and

upper limits to avoid optimization failure and

select central finite difference for the derivative

evaluation method. Use the default value for

numerical precision and select No for change

derivative step sizes.
 

NOTE: An alternative method is to select Yes to hold

any parameter at present value. This method is

described further in the discussion: optimization of

parameters.

33. From the Optimization menu, select begin

optimization. The CRUNCH program will optimize

the selected TCID model to the experimental data.
 

NOTE: If the optimization does not find satisfactory

fits, from the changes menu, try changing the

energy range to cover just the first few intensities

rising from the thresholds. When a reasonable

fit is located, increase the energy range and fit

https://www.jove.com
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again. Other options that can help find fits to

the data include choosing to hold any parameter

at present value in parameters optimized and

changing weighting options in weights. See the

discussion for these options.

34. When a model fit to the data is found, hit Enter until

the Model menu appears. If only part of the energy

range of experimental data is fitted with the TCID

model, select Calculate and convolute model to

extend the model fit to all experimental collision

energies.

35. In the Model menu, select Delta H and S at T.
 

NOTE: The unconvoluted CRUNCH model relates

the 0 K threshold energies to the 0 K enthalpies

(ΔH0) of dissociation of the ternary complex into

the two independent product channels (Table 2).

The 298 K enthalpies (ΔH298) and Gibbs free

energies (ΔG298) of dissociation are also derived

with statistical mechanics thermal and entropy

corrections using the reactant and products PM6

rotational and vibrational frequencies.

Representative Results

The competitive collision-induced dissociation of the [amb

+M(II)+NTA]-  ternary complexes of A and H into [amb+M(II)]-

+ NTA or [NTA+M(II)]-  + amb, are shown in Figure 3. The

amb is shown as either A or H and the M = Zn or Ni. The [A

+Zn(II)+NTA]-  ternary complex (Figure 3A) exhibits apparent

thresholds of about 0.7 eV collision energy (CE) to produce

[A+Zn(II)]-  and about 0.9 eV to produce [NTA+Zn(II)]- . The

dissociation of the [A+Ni(II)+NTA]-  complex (Figure 3B)

exhibits similar thresholds (~1.1 eV) for both the [NTA+Ni(II)]-

and [A+Ni(II)]-  products, with [NTA+Ni(II)]-  increasing to 90%

relative intensity, while the intensities of [A+Ni(II)]-  do not rise

above 18%. For the [H+Zn(II)+NTA]-  ternary complex (Figure

3C), the main product is [H+Zn(II)]-  rising from a threshold of

about 0.6 eV to about 85% relative intensity, and at energies

above 1.0 eV, the [NTA+Zn(II)]-  rises to about 30%. There

is also a channel for water loss from [H-H2O+Zn(II)]- . For

[H+Ni(II)+NTA]-  (Figure 3D), the [H+Ni(II)]-  rises from a

threshold of about 0.9 eV to about 40% relative intensity, while

the [NTA+Ni(II)]-  rises from ~1.0 eV to about 80%. Included

on the graphs is the CE where the ternary complex is 50%

dissociated. The Ni(II) ternary complexes require 0.31-0.37

eV higher CE than their Zn(II) ternary complex counterparts

to be 50% dissociated. This suggests the Ni(II) complexes

are more stable and require higher CE to dissociate, which is

further investigated using the TCID technique.

Figure 4 illustrates the competitive TCID method, which

allows for the simultaneous fitting of the two competing

product channels.

[amb+M(II)+NTA] → [amb+M(II)]-  + NTA (1)

[amb+M(II)+NTA] → [NTA+M(II)]-  + amb (2)

The potential energy surface (PES) illustrates the energized

ternary complex dissociating into the competing product

channels and shows the PM6 geometry-optimized species

used to model the dissociation of [ambH+Zn(II)+NTA]- .

Included in the PES are the density of states of the ternary

complex and the sum of states of the products. The 0 K

threshold energies, E1 and E2, equate to the 0 K enthalpy

change for reactions 1 and 2.

Figure 5 shows the structures of the other three geometry-

optimized ternary complexes used in this study. These

species were chosen based on their predicted electronic and

zero-point energies and their agreement with the IM-MS-

measured collision cross-sections (CCSHe). Table 1 shows

https://www.jove.com
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there is an agreement between the ternary complexes LJ

CCSHe and the experimental IM-MS CCSHe because they

agree within their mutual uncertainties. The conformations of

the [amb+M(II)] and amb were based on the findings of our

previous DFT modeling3,4 ,5 ,6 . The molecular parameters of

these PM6 conformers were used in the TCID modeling of

the energy-resolved dissociations of the ternary complexes,

including their ro-vibrational frequencies for calculating their

density and sum of states.

Figure 6 shows the convoluted CRUNCH TCID threshold fits

to the energy-resolved product intensities. The convoluted

fits include the available energy and angular momentum

distributions of the [amb+M(II)+NTA]-  + Ar reactants. The

unconvoluted fits (not shown) predicted the 0 K change in

enthalpies (ΔH0) for the dissociation of the ternary complex,

and Table 2 shows the ΔH0 and ΔH298 (kJ/mol) for reactions

1 and 2. For the dissociation of the Zn(II) ternary complexes,

both A and H exhibit ΔH0 for reaction 1, which are 31

kJ/mol and 15 kJ/mol lower than the ΔH0 for reaction 2,

respectively, indicating both A and H have greater Zn(II)

affinity than the NTA. The [A+Ni(II)+NTA]-  ternary complex

exhibits ΔH0 = 146 and 148 kJ/mol for reactions 1 and 2,

respectively, indicating A and NTA have similar affinities for

Ni(II). However, the dissociation of [H+Ni(II)+NTA]-  shows the

ΔH0 for reaction 1 is 36 kJ/mol lower than for reaction 2,

indicating H has a greater Ni(II) affinity than the NTA. Overall,

the [amb+Ni(II)+NTA]-  complexes exhibit higher dissociation

enthalpies than their [amb+Zn(II)+NTA]-  counterparts, with

the exception of A dissociating into [NTA+Ni(II)]- . Table 3

shows the Gibbs free energies (ΔG298) of association and

the formation constants (K) for the reverse reactions:

[amb+M(II)]-  + NTA → [amb+M(II)+NTA]-  (3)

[NTA+M(II)]-  + amb → [amb+M(II)+NTA]-  (4)

Table 3 demonstrates that the formation of the Ni(II) ternary

complexes is more exergonic and exhibits larger formation

constants K than the Zn(II) complexes in all cases. Reaction 4

(i.e., the amb tag association with the NTA metal ion complex)

is of particular interest as it represents the amb-tagged

recombinant protein binding to the NTA-immobilized metal

ion inside the IMAC column. Reaction 4 for the formation of

[ambA+Ni(II)+NTA] exhibits the most spontaneous ΔG298 =

53.1 kJ/mol and the highest formation constant, K = 2.01 x

109 .

https://www.jove.com
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Figure 1: Overview of the ES-IM-MS TCID method. Please click here to view a larger version of this figure.
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Copyright © 2022  JoVE Journal of Visualized Experiments jove.com June 2022 • 184 •  e63722 • Page 16 of 27

 

Figure 2: The primary structures of amb A and H peptides. Color highlights the potential metal-binding sites. Please click

here to view a larger version of this figure.
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Figure 3: The center-of-mass, energy-resolved (eV) threshold collision-induced dissociation of [amb+M(II)+NTA]- .

The energy-dependence of the product ions [amb+M(II)]-  [NTA+M(II)]-  and [amb-H2O+Zn(II)]-  is shown. The center-of-

mass collision energy, where there is 50% dissociation of the [amb+M(II)+NTA]-  ternary complex, is included on the graphs.

Please click here to view a larger version of this figure.
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Figure 4: The model for the energy-resolved TCID method. The collisions between [ambH+Zn(II)+NTA]-  + argon

result in the dissociation to the [ambH+Zn(II)]-  + NTA or [NTA+Zn(II)]-  + ambH products. The threshold energies E1 and

E2 equate to the 0 K enthalpies of dissociation (ΔH0) for the reactions [ambH+Zn(II)+NTA]-  → [ambH+Zn(II)]-  + NTA or

[ambH+Zn(II)+NTA]-  → [NTA+Zn(II)]-  + ambH, respectively. Please click here to view a larger version of this figure.

 

Figure 5: The PM6 geometry-optimized ternary [amb+M(II)+NTA]-  complexes of A and H. Conformers used in the TCID

modeling of the experimental data. These conformers were selected from other candidate structures by comparing their PM6

electronic energies and how their LJ collision cross-sections (CCSHe) compared to the IM-MS measured CCSHe. Please

click here to view a larger version of this figure.
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Figure 6: The energy-resolved, collision-induced dissociation of [amb+M(II)+NTA]- . For species A and H, the product

ions of [amb+M(II)]-  and [NTA+M(II)]-  with the convoluted CRUNCH threshold fits are shown. The energy (eV) values shown

are the enthalpies of dissociation at 0 K for the reactions [amb+M(II)+NTA]-  → [amb+M(II)]-  + NTA or [amb+M(II)+NTA]-  →

[NTA+M(II)]-  + amb. Please click here to view a larger version of this figure.

https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/63722/63722fig06v2large.jpg


Copyright © 2022  JoVE Journal of Visualized Experiments jove.com June 2022 • 184 •  e63722 • Page 20 of 27

 

Figure 7: The format for the CRUNCH text input file. The file contains the mean relative intensities and their standard

deviations of the product ions formed as a function of center-of-mass collision energy. Please click here to view a larger

version of this figure.

https://www.jove.com
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amb [amb+Zn(II)+NTA]- [amb+Ni(II)+NTA]-

PM6 Exp.a PM6 Exp.a

A 214±2 214 219±2 218

H 211±5 216 212±3 215

a ES-IM-MS CCSHe measurements have uncertainties of ±4 Å2 .

Table 1: Comparison of LJ collision cross-sections of the PM6 conformers of [amb+M(II)+NTA]- . Theoretical cross-

sections of the PM6 conformers are compared with the experimental CCSHe measured with ES-IM-MS.

[amb+Zn(II)+NTA]-  → [amb+Ni(II)+NTA]-  →

[amb+Zn(II)]-  + NTA [NTA+Zn(II)]-  + amb [amb+Ni(II)]-  + NTA [NTA+Ni(II)]-  + amb

amb ΔH0 ΔH298 ΔH0 ΔH298 ΔH0 ΔH298 ΔH0 ΔH298

A 118 127 149 182 146 171 148 154

H 96.4 92.3 111 115 125 140 161 216
 

 

Table 2: Thermochemical results from the TCID analyses. The energy-dependent reactions [amb+M(II)+NTA]-  → [amb

+M(II)]-  + NTA or [amb+M(II)+NTA]-  → [NTA+M(II)]-  + amb, showing the 0 K enthalpies of dissociation (ΔH0) derived from

the unconvoluted TCID model fit, and 298 K enthalpies of dissociation (ΔH298) derived from ΔH0 and statistical mechanics

thermal corrections using the PM6 rotational and vibrational frequencies. Values are given in kJ/mol.

https://www.jove.com
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[amb+Zn(II)]-   + NTA → [NTA+Zn(II)]-  + amb → [amb+Ni(II)]-  + NTA → [NTA+Ni(II)]-  + amb →

[amb+Zn(II)+NTA]- [amb+Zn(II)+NTA]- [amb+Ni(II)+NTA]- [amb+Ni(II)+NTA]-

amb ΔG298 K ΔG298 K ΔG298 K ΔG298 K

A -34.0 9.05 x 105 -21.8 6.59 x 103 -45.7 1.01 x 108 -53.1 2.01 x 109

H -29.3 1.36 x 105 -30.2  1.95 x 105 -47.0 1.71 x 108 -31.1 2.81 x 105
 

 

Table 3: Gibbs free energies of association (ΔG298) and equilibrium formation constants (K). ΔG298 and K at 298 K

for the reverse reactions [amb+M(II)]-  + NTA → [amb+M(II)+NTA]-  and [NTA+M(II)]-  + amb → [amb+M(II)+NTA]- . Derived

from ΔH298 and statistical mechanics entropy calculations using the PM6 rotational and vibrational frequencies. Values for

ΔG298 are in kJ/mol.

Supplementary File. Please click here to download this File.

Discussion

Critical steps
 

ES-IM-MS threshold collision-induced dissociation

(TCID) analyses. The TCID used the transfer T-wave cell

in the presence of argon as the collision cell. Prior to

dissociation, the precursor ions are thermalized by low-

energy collisions with nitrogen gas as they pass through the

ion mobility (IM) cell. This results in a more reproducible

energy-resolved TCID than is achieved by using the trap

as the collision cell6,40 . The thermalization of the [amb

+M(II)+NTA]-  prior to dissociation also allows the available

internal energy of the ternary complex to be characterized

using 298 K temperature. The dissociation in the transfer cell

also means the ternary complex and its product ions have the

same average arrival times at the detector, which was useful

for identifying the dissociation of the ternary complex that only

occurred in the transfer cell. Other regions where dissociation

can occur are the ES source (sampling cone is kept at 25 V

to avoid this) or at the entrance of the IM cell. The product

ions produced by the dissociation of the ternary complex in

these regions have different drift times from those produced

in the transfer cell because the product ions are separated

from the ternary complex in the IM cell. Those product ions

were excluded from the analysis. In this protocol, only the

integrated arrival time distributions for the precursor and

product ions that are co-aligned are used to determine their

intensities. The trap bias setting is the voltage that controls

the injection voltage into the IM cell, which contributes to the

CID at the entrance of the IM cell. The trap bias was set at

14 V, which kept the background dissociation to a minimum

while not overly affecting the overall intensities. A previous

study41  determined the effective temperature (upper limit) of

the peptide dimer of leucine enkephalin to be 449 K at the

entrance of the IM cell. However, the effective temperature

decreased rapidly as the dimer passed down the IM cell. The

arrival times of the amb complexes studied here exhibited

Gaussian distributions, indicating they were thermalized as

they passed down the IM cell.

https://www.jove.com
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ES-IM-MS collision cross sections (CCS) analyses. CCS

drift times were found experimentally as the result of collisions

with nitrogen. Those values were converted to helium-derived

CCS drift times using a calibration curve of known standards.

This is essential as the programs used to measure the CCS of

the PM6 conformers require the more commonly used helium

standards.

Modifications and troubleshooting of the technique
 

CRUNCH input text file format. The input text file suitable

for the CRUNCH program is shown in Figure 7. The headers

in order from top to bottom are file location and version

of CRUNCH; date; number of energies; number of data

series excluding the first energies column; source file; mass

of the precursor complex; mass of argon; temperature of

experiment; date of creation; x-data designated as −1 (the

center-of-mass collision energies); and the full width at half

maximum (FWHM) of the ion beam. These values must

be modified for each TCID experiment. The FWHM energy

spread of the ion beam and energy zero should be determined

by retarding potential analysis (RPA) by scanning the CE

through low voltages and monitoring the total ion current.

However, under the operating conditions of the IM in the

current study, the ion current signal only decreased by about

50% when the transfer CE was set to its lowest value. The ion

beam energy zero and FWHM could be measured only upon

additional retardation by lowering the exit IM lens. In this latter

case, the FWHM of the derivative of the RPA curve gave a

typical ion energy spread of 1.5 V in the lab-frame or 0.035

eV in the center-of-mass frame13 .

The pressures row relates to pressure inside the collision cell

but is not used here. The pressures of argon in the collision

cell can be varied and the TCID data can be measured at

three pressures to extrapolate to single collision conditions.

However, only one pressure was used in this study, and

the pressure results in multiple collisions. Developing the

new platform for a single collision is an area of ongoing

research. Masses relate to the two product ions whose

intensities are in the columns below. Dwells can be left as

default. The five columns are the center-of-mass collision

energies (designated −1); the mean of the ion intensities

of the species with mass 898.30 u; the standard deviations

of the ion intensities of species 898.30 u; the mean of the

ion intensities of the species with mass 253.53 u; and the

standard deviations of the ion intensities of species 253.53 u.

Molecular Modeling
 

The number of conformers were narrowed initially by

using models derived from previous studies9,10 ,11 ,12 ,13 .

CRUNCH fitting requires careful screening of reactants,

activated molecules, and transition states to obtain accurate

threshold energies. Previous research9,10 ,11 ,12 ,13  has

included extensive screening of [amb+M(II)] conformers

to obtain the structures with the parameters used in

the CRUNCH modeling here. Only complexes with trans

peptide bonds were used because only they are in

agreement with IM-MS measured CCSHe10 . The B3LYP

and PM6 molecular modeling methods both predict the

lowest energy [amb+M(II)]-  conformer that exhibits Aa1-

Cys2-Cys7 and carboxylate terminus coordination of Zn(II)

or Ni(II)10,11 ,12 ,13 . Familiarity with the behaviors of the

known models allowed for the new conformers of [amb

+M(II)+NTA]-  to be determined more efficiently. To assist

in conformer determination, as lower energy conformers

were located by the PM6 method, they were filtered out

and reassessed systematically until the most feasible, lowest

energy conformers remained.

CRUNCH modeling
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Time-window for observing dissociation. In this study, the

50 μs time window from the beginning of the transfer cell to

the end of the TOF analyzer, where the multichannel plate

detector is positioned, was used. It may be better to use the

experimental time window between activation in the transfer

cell and the entrance to the TOF mass analyzer because, if

the activated ion dissociates during its time in the reflectron

TOF, this metastable decay will be measured at a different

m/z. However, in this study, the product ions observed in

the mass spectra were all identifiable as the unmodified m/

z species shown in Figure 3. This indicates that metastable

decay was not an issue. Further research could investigate

this by examining a known reaction with a high threshold and

checking that the correct threshold energy is obtained using

the 50 μs time window and RRKM modelling.

Scaling factors for the vibrational frequencies. The NIST-

recommended scaling factors for PM6 (1.062) vibrational

frequencies were used. These were satisfactory for fitting

the [A+Zn(II)+NTA]- , [A+Ni(II)+NTA]- , and [H+Zn(II)+NTA]-

data. For some cases where the higher energy channel is

entropically favored over the lower energy channel, it may be

necessary to additionally scale the frequencies of the second

channel. One approach is to scale the frequencies below

900 cm−1  (as these are the least accurate) to loosen the

frequencies and make the TS more entropically favored.

Optimization of parameters. Using the Yes option to Hold

any parameter at present value can be helpful to fit the data

successfully. For the first fit, the E0(2) is held and the model

TCID is fitted to the data by optimizing the CONST, E0(1),

and N variables. Once a good fit is located, the parameters

option and Hold any parameter at present value can be

used to hold CONST, E0(1), and N, while allowing E0(2) to

optimize to the data. Finally, once E0(2) is optimized, in the

parameters option, all four parameters CONST, E0(1), E0(2),

and N should be allowed to optimize to the data.

Energy range for fitting the selected TCID model to

the experimental data. The energy range used to fit

the experimental data should reproduce as much of the

experimental intensity data as possible while maintaining a

good fit in the threshold region. One can start by fitting the

TCID model to a small energy range at the thresholds of

the experimental data. One can choose a starting energy

that exhibits the background intensity just prior to the rising

intensity threshold behavior. Once the TCID fit is optimized to

the experimental data range, the range should be increased

by 0.1 eV and the fit should be optimized again. This

procedure should be repeated to fit as much of the data range

as possible while maintaining the fit of the threshold region.

Thermochemical Analyses. The thermochemical results

from Delta H and S at T option should be compared with a

series of different energy range fits to the data to estimate

the standard deviation of the TCID model fit. Fits to compare

should include smaller ranges that fit the initial rising threshold

intensities well with those with greater ranges that include the

higher energies as well.
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